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Key terms 
 

Cascade CMS 
 
Cascade is an application that runs in your web browser. It is a "Content Management System." 
We use it to organize and prepare documents to be published to the Internal resources server 
(inside.tamuc.edu/). 
 

Internal resources server (inside.tamuc.edu/) 
 
We publish our internal resources to a server with the web address of inside.tamuc.edu.  This 
includes information for current students, faculty and staff. Forms, documents, meeting minutes 
and other resources shared by your department may be published here. Information for future 
students, parents, alumni and the general public, such as academic programs, contact 
information, faculty and staff profiles, news and upcoming events, should be published on the 
marketing website (www.tamuc.edu). Avoid publishing information on both domains. It is better 
to have just one document to keep information up to date. 
 

Webpage 
 

A document formatted to display content in a web browser. Published webpages on the Internal 
resources server (inside.tamuc.edu/) end with .aspx. In Cascade, they do not have a file 
extension. 
 
Example: (https://inside.tamuc.edu/aboutus/administrativeOffices/president/default.aspx)  

 
URL 
 
The address of a webpage. At ETAMU, all webpages published with Cascade have a URL that 
begins with "https://inside.tamuc.edu/."  
 
Example:(https://inside.tamuc.edu/aboutus/administrativeOffices/president/default.aspx) 

 
Hyperlink 
 
A link on a webpage to another webpage or document. The user activates the hyperlink by 
clicking on an underlined word and blue in the content area. 

 
Link text 
 
The visible text of a hyperlink. This text should always describe where the hyperlink will take the 
user by clicking on it. 

 
 
Publish 
 
In Cascade, when you "publish" an item, you export it to the internal resources server 

http://www.tamuc.edu/
https://inside.tamuc.edu/


(inside.tamuc.edu/), making it available to everyone on the internet. When you update a 
document in Cascade, that change only exists in Cascade until you publish it. Once you publish 
it, it is available to everyone on the internet. 

 
Logging into Cascade 
 
To log into Cascade, you must be connected to the university Network, either through your 
office's ethernet port or through the Paloalto VPN. 

1. In your web browser, go to https://cms.tamuc.edu/ 
2. Log in using your university username and password (the same credentials you use to 

log into your computer and SSO). 
 
Note: If the login page does not load, you are not connected to the university Network. You 
must connect your computer to an ethernet port in your office or use Paloalto VPN software to 
connect remotely. If you do not have the Paloalto VPN software on your computer, contact 
helpdesk@tamuc.edu for assistance installing it. 
 
To make sure you are connected to the VPN: 

1. Open the Paloalto VPN software and use ra-vlan28.tamuc.edu for the "portal setting." 
This should be located at the right corner of your screen 

2. To log in, use the username and password that you use to log into your computer. 
3. You will receive a notification from Duo Authentication. 
4. Once you've verified using the Duo app or telephone, the Paloalto VPN software will log 

you into the University VPN. 
5. Now, when you go to https://cms.tamuc.edu/, you should see the login page. 

 
 

 

 

 

 

 

 

 

 

 

Application Tour - Navigating the Cascade Interface 
 
Site Selector 
 
Use the site selector to switch to your specific site by clicking on the downward arrow. The 
Cascade content is organized into sites based on department.

https://cms.tamuc.edu/
https://cms.tamuc.edu/


 

 
Search 
 
The search function is frequently the best way to find a file or webpage you need to edit.

 

 
 

 

Sidebar Tree 
 

● The sidebar tree, located on the left side of the screen, displays your site's folder 
structure. Documents and webpages are organized inside folders, just like on your 
computer. The order of these folders determines the navigation menu on the published 
webpage and the URL link for each webpage. 



 
● Open and close folders by clicking the plus and minus buttons next to the folder icons. 
● Click on a folder or document to display information about it in the Main Stage and make 

edits. 

 
 
 
 
 
 
 
 
 
 
BONUS SHORTCUT  
 
Hover the mouse over a folder or document and click on the "Context Dropdown Arrow." You 
can now quickly access one of the tabs in the Main Stage.  



 

 
Main Stage 
 
The largest area is called the "Main Stage." It displays information and options about the item 
selected on the left. 

 
 
 
 
 
 
 

View Tab 
 

Preview: Layout presents a preview of the document or webpage. The preview does not look 
exactly like the final published webpage. 
Live: Gives you a URL link to see the published page. 



Note: Properties, Lock and outputs are only used by Helpdesk or Marcomm. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Edit Tab 
 
Content: This is where you can edit the text and images appearing on the webpage when 
published. 
Move/Rename: This is where you can move and/or Rename a document.  



Copy: This is frequently the fastest way to create a new page. When you copy a page, make 
sure you update all relevant fields, such as the Display Title, Title, Parent Folder, and System 
Name. 
Publish: This lets you publish a webpage, document or folder to the internal server 
(inside.tamuc.edu/). 

 
 
Note: When moving or renaming, always be sure to have the "Unpublish Content" option 
checked. If it is unchecked, the document will remain on the live site and be difficult to remove. 
It will continue to show up in Google search results with old information. If you think this has 
happened, contact helpdesk@tamuc.edu right away. 

 
 
 
Note: You can also publish a folder to publish all the items inside it. 

mailto:helpdesk@tamuc.edu


 
 
More Tab 
 
Delete: This lets you remove a document from the Cascade content management system. You 
can not undo this command. 
Versions: This lists a history of all of the versions of the webpage and who made the changes. 
Versions can be helpful when tracking down the stakeholders for a webpage. 
Access, Audits and References are used by Helpdesk and Marcomm. 

 
 
IMPORTANT NOTE: If you delete a document from Cascade, make sure "Un-publish Content" 
is checked. If it is not checked, the document will remain on the live site and be difficult to 
remove. It will continue to show up in Google search results with old information. If you think this 
has happened, contact helpdesk@tamuc.edu right away. 

Quick How-Tos 

mailto:helpdesk@tamuc.edu


Finding an item via Search 
 
When searching for a document, include the extension (.pdf, .doc, .ppt)  
 
Example PDF: https://inside.tamuc.edu/facultystaffservices/documents/ProductPricing.pdf If 
you were looking for this PDF document in Cascade, you will search for just the term 
"ProductPricing.pdf" because that is the text that appears after the last slash in the URL link. 

 
 
 
When searching for a webpage with .aspx at the end of the URL, exclude the ".aspx" extension 
from your search term. 
 
Example Webpage: https://inside.tamuc.edu/facultyStaffServices/documents/OldPage.aspx 
When looking for this webpage, the search term should be "OldPage," NOT "OldPage.aspx" 

 
 
 
 
 
 
Steps to Search 

1. Click inside the search box. 

https://inside.tamuc.edu/facultystaffservices/marketingCommunications/documents/ProductPricing.pdf
https://inside.tamuc.edu/facultystaffservices/marketingCommunications/documents/ProductPricing.pdf
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx


2. Paste or type the name of the document you are looking for 
3. Press the enter key on your keyboard. 
4. Clicking on the name in the search result will take you to the view tab for that document. 

 
Unpublish an Item or Folder 
 
Unpublishing things on Cascade will unpublish the item from the internal resources server 
(inside.tamuc.edu/), making it inaccessible to Google and removing it from the navigation menu 
on other Cascade pages. The best way to unpublish a webpage, document or folder is to simply 
move it to your site's "_unpublished" folder.  

 
 
Quick and Easy Way - Using ‘unpublished’ folder 

1. Drag and drop the item onto the "_unpublished" folder.  
a. In the Sidebar Tree, Click and hold the item's icon. 
b. Continuing to hold the mouse button down, drag the item over the folder titled 

"_unpublished." 
c. The "_unpublished" folder will highlight 
d. Release the mouse button. 

2. Result: This will open that item's Move/Rename tab and preselect the "_unpublished" 
folder as the "parent folder." 

3. Select "Unpublish" from the "Publish Mode" option. 
4. Click "Submit." 

 
Without using the "_unpublished" folder 

1. Unpublish from the internal resources server (inside.tamuc.edu/)  
1. Select the item in the Sidebar Tree 
2. Select the "Publish" tab 
3. Select "Unpublish" from the "Publish Mode" option 
4. Click "Submit." 

2. Rename the item in Cascade  
1. Select the "Move/Rename" tab 



2. Add an underscore (_Example) to the beginning of the folder to indicate that it is 
unpublished 

3. Click "Submit." 
3. Set not to republish automatically  

1. Select the Edit Tab 
2. Uncheck "Include when publishing" and "Include when indexing" 
3. Click "Submit." 

 
Important note: When you move, rename or delete a document from Cascade, ensure "Un-
publish Content" is checked. If it is not checked, the document will remain on the live site and be 
difficult to remove. It will continue to show up in Google search results with old information. If 
you think this has happened, contact helpdesk@tamuc.edu right away. 
If you have unpublished or deleted a page or document, please remove hyperlinks pointing to 
the deleted URL of the page or document, or users will be sent to 404 pages. If there are issues 
with this process, ask Marcomm to help find dead links after removing a page or document. 

 
Publishing and Updating a folder, document or webpage. 
 
In Cascade, when you "publish" an item, you export it to the internal resources server 
(inside.tamuc.edu/), making it available to everyone on the internet. When you change a 
document in Cascade, that change only exists in Cascade until you publish it. 

 
Steps to Publish a folder 

1. Hover over the item 
2. Click the "context dropdown" menu 
3. Select "Publish" 
4. Click Submit 

 
Notice: Publishing a folder will publish everything inside that folder. 

 
 
Identify the URL of a page. 



● Select the document in the Sidebar Tree. 
● The View tab is selected by default. 
● Select Live. 
● The URL hyperlink to see the page published on the internal resources server 

(inside.tamuc.edu/) is listed at the top. 
 

 
 
 
Update a document  

1. Select the document in the Sidebar Tree. 
2. Select the Edit tab. 
3. To keep the URL of the document the same, do not change the name. 
4. Click the "Choose File" button. 
5. Navigate to the file on your computer and open it. 
6. Click "Submit." 
7. Now, Publish to replace the old document with the new one on the internal resources 

server (inside.tamuc.edu/). 
 

Upload a new document  
1. In the blue menu bar, select New > Default > File. 
2. Click the "Choose File" button. 
3. Navigate to the file on your computer and open it. 
4. Click "Submit." 
5. Now, Publish to make the file available on the internal resources server 

(inside.tamuc.edu/). 
 
Common next steps:  
Now that you have uploaded a new document, you probably want to hyperlink it on a page.  

 
 

 

 

Updating Title and Content  



Update the title of an existing webpage. 
 
The "Title" field is located under the Edit, Content tab and determines the text in the navigation 
menu on the left and the webpage title (as long as the "Put Title in Content?" option is checked). 

 
 
Edit Text on an Existing Webpage 
 
Basic Steps Update a web page 

1. Select a webpage in the Sidebar Tree. 
2. Select the edit tab in the Main Stage. 
3. Make the changes in the content area. 
4. Click "Submit." 
5. Review any spelling issues. 
6. Review any link issues. 
7. Click "Submit." 

 
Create a hyperlink 
 
Before you hyperlink, here are some guidelines for creating links on web pages. 

● Link text should describe where the hyperlink takes you and be embedded in text around 
it. 

● Do not use the URL as the link text. 
● Do not use "Click here" and "Read more" for the link text. When screen readers hear 

these links, it is unclear where the link will take them. 
Examples: 

● Do: We have over 100 rich traditions. 
● Don't: https://inside.tamuc.edu/facultyStaffServices/documents/traditions.aspx. 
● Don't: For a list of our 100 rich traditions, click here. 

 
Steps to Create a Hyperlink  

1. Select the text you wish to make into a link in the content area. 
2. Click the Link icon at the top of the text box. 

https://inside.tamuc.edu/facultyStaffServices/documents/traditions.aspx.
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx
https://inside.tamuc.edu/facultyStaffServices/marketingCommunications/documents/popbox.aspx


3. Select link type  
○ Internal: Select "internal" to Select another webpage in Cascade. This method is 

best practice because Cascade automatically updates the link if the webpage is 
renamed or moved. 

○ External: Select External to add a full URL such as "https://tamuc.edu/map." 
4. Click "Insert” 
5. Click "Submit." 

 
Steps to Change a Hyperlink  

1. Select the full text of the link you want to change in the content area. 
2. Click the Link icon at the top of the text box. 
3. Select link type  

○ Internal: Select "internal" to Select another webpage in Cascade. This method is 
best practice because Cascade automatically updates the link if the webpage is 
renamed or moved. 

○ External: Select External to add a full URL such as "https://tamuc.edu/map." 
4. Click "Insert" 
5. Click "Submit." 

 
Create an email link. 

1. Type or select the text you wish to make into a link on the webpage. 
2. Click the Link icon at the top of the text box 
3. Select "External" 
4. Type "mailto:" plus the email address with no spaces in the link field  

○ Example: to make a link to webmaster@tamuc.edu, type 
"mailto:webmaster@tamuc.edu" in the link field 

5. Click "Insert" 
6. Click "Submit." 

 
Convert a paragraph into a list. 

1. Select the text that should be a list 
2. Click the Unordered list link for bullet points or the ordered list link for a numbered list 
3. Click “Submit” 

 
Create a new list. 

1. Place the cursor on a new line 
2. Click the Unordered list link for bullet points or the ordered list link for a numbered list 
3. Start typing your list 
4. Use the return key to create a new list item 
5. Click “Submit” 

 
Move or Rename Items. 
 
Important notice: When renaming or moving items in Cascade, you are also changing the 
published file name and/or moving that item on the internal resources server 
(inside.tamuc.edu/). That means you are changing the URL link of that webpage and potentially 
breaking any links to that webpage that are published anywhere outside of Cascade, such as in 
emails, PDFs, webpages on WordPress, printed documents, etc. If you change the name of a 
folder, you will need to change the URLs for every webpage and document under that folder as 

http://tamuc.edu/map
http://tamuc.edu/map


well. The links in the left menu bar and internal links on Cascade webpages will be broken until 
those folders are republished. 
 
Notes for Naming Items 
Folders, documents and webpages should never contain spaces or special characters 
(example: !@#$%^&*) in their filenames. Capitalize each word in the folder or name to make it 
easier to read. 

1. Select the item 
2. Select the "Move/Rename" tab 
3. Make sure "Unpublish Content" is not selected 
4. Click "Submit." 

 
Example of an improper name: Marketing andCommunication!@#$%^*, while 
MarketingCommunications would be the proper choice. 
 
Note: This change happens in Cascade and on the live site when you click "submit". However, 
after renaming a folder, you’ll need to publish it for all of the web pages and documents inside it 
to be published. Those web pages will remain unpublished until the folder is published. 

 
Copy, Move, Publish, or Delete multiple items in a folder. 

1. Select a folder in the Sidebar Tree.  
1. A list of the contents of the folder appears in the Main Stage 

2. Select the check boxes next to the items you wish to modify 
3. Use the "with selected" dropdown menu to select an action 
4. For copy or move, select the destination. Click "Browse..." to navigate to anywhere on 

the site. 
5. Click "Submit." 

 
Common Issues and Quick Solutions 
 
Common Issue: You are trying to unpublish an item, and the item does not want to unpublish.   
 
Solution: You’ll need to go check certain settings in the System for the item. This can be found 
under the Edit tab. The "Include when publishing" option is here. Uncheck this to keep content 
in Cascade but prevent it from being published to the internal resources server 
(inside.tamuc.edu/). You may have to go here to check the item, unpublish the item and then go 
back here to uncheck "Include when publishing" again.  
 
If unable to complete it, please contact Marcomm. 

 
Gaining proper Permissions  
 
As a staff or faculty member wanting to make updates on cascade, you need to understand 
what access or permissions you have. When logging in to Cascade for the first time, check the 
New on the blue bar. You should have the following options; Page, Image File, Empty Folder, 
and Message.  
 
On the Main Stage, you should have access to ‘View Tab’, ‘Edit Tab’, ‘Publish Tab’ and ‘More 



Tab’. 
 
If you notice you don’t have the access mentioned above as a staff or faculty member, please 
contact the Helpdesk at Helpdesk@tamuc.edu to gain access.  

 
 
 
 
 
 
 
 
 
 

mailto:Helpdesk@tamuc.edu
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